
DESIGN OF General Structures
Integrated Design System for Building and General Structures

Release Note
Release Date : December. 2020

Product Ver. : midas Gen 2021 (v1.1) and Design+2021(v1.1)
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Enhancements

1) Improvement of Non-dissipative design speed

2) Improvement of Non-dissipative element as per NTC2018

3) NTC2018 limits the shear force for design

4) Concrete design result of elastic strength load combination

5) Add option of pushover Hinge Model as per EC 8 :2004 

6) Add  irregularity reduction factors  in table as per NSR-10

7) Improvement of wind pressure function 

8) Add rebar material code DB ( U.S Imperial rebar)

9) Improvement of concrete shear strength in SMF

10) Add element type of Beam End Offsets function

11) Add Static earth pressure function

12) Elastic link graphic result in pushover analysis

13) Debonded Length of Pretensioned Beam

14) Revit 2021 interface

• midas Gen
4

• midas Design+
1) Support on excel report output

2) SRC column module adding steel shape(box/pipe)

3) Midas link option

4) Add Combined Footing Design as per Eurocode

5) Reporting speed for MS word format
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• Reduction of design time by optimizing m-phi calculation and improving the output algorithm

1. Improvement of design speed for Non-dissipative elements

Gen 2020

Gen 2021

Time for M-Phi Calculation Times for Design

 Beam/Column : 1,974 Elements

 Wall : 216 Elements

 Load Combination : 100

664.01sec

Example Model ( RC structure of 6F )

[Total ND Design Time :  Gen 2020  vs  Gen 2021(New Version)]

60% reduction in design time

Saved Times

274.54sec 389.47sec

midas Gen
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2. Improvement of Non-dissipative Design as per NTC2018 

Non-dissipative in flexural & Shear design – Design Table
- Output of separated results for ULS except seismic action) and ELS with seismic modified by q for non-dissipative elements

* LC_A : Load combination to check ULS(Ultimate Limit State) except seismic loads

* LC_E : Load combination to check ELS(Elastic Limit State)

* LC_S : Load combination to check SLS(Serviceability Limit State)

Ultimate Strength Check (LC_A) in graphic design 

Elastic Strength Check (LC_E) in graphic design 

Serviceability Check (LC_S) in graphic design 
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2. Improvement of Non-dissipative Design as per NTC2018 

Non-dissipative in flexural & Shear design : Graphic report
- Output a design results for ULS, ELS and SLS separately in design reports.

Design result for ULS(Ultimate Limit State) Design result for ELS(Elastic Limit State)

Design result for SLS(Serviceability Limit State)
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Design Shear force of primary elements according to NTC 2018
- When calculating a design shear force for primary elements, member force can be limited by a resistance demand for ELS load 
combinations.

The resistance demand evaluated with the capacity design criteria 
can be assumed not higher than the resistance demand evaluated 
for the case of non dissipative structural behavior.

Design report (Detail)

3. Improvement for Shear design as per NTC2018

VzOrig = Design shear force by ULS load combination

Ve1(M) = Design shear force by flexural strength of member.

Ve1(E) = Design shear force by ELS load combination.

V_Ed = Max [VzOrig, Min[Ve1(M), Ve1(M)]]
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3. Improvement for Shear design as per NTC2018

Design Shear force of primary elements according to NTC 2018
- When calculating a design shear force for primary elements, member force can be limited by a resistance demand for ELS load 
combinations.

Check on optionCheck off option

--> V_Ed = Max [VzOrig, Min[Ve1(M), Ve1(E)]]

VzG = Design shear force by load combination with only gravity loads.

Ve1(M) = Design shear force by flexural strength of member.

Ve1(E) = Design shear force by ELS load combination.

--> V_Ed = Max [VzOrig, Ve1(M)]

Option is added.

Design Setting
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4. Concrete design result for ELS load combination

Add Graphic result for ELS Load combination.

 ULS : Load combinations assigned to “Strength/Stress” type in Load combination dialog box

 ELS : Load combinations assigned to “Strength(Elastic)” type in Load combination dialog box



Gen 2021 v1.1 Release Note

10 /31

New hinge curve model as per Eurocode 8 :2004 
- Add a hinge curve with “Du update” type

5. Improved Hinge Curve Model as per EC 8 :2004 

midas Gen

Dy1 Dy2 Du1 Du2

Stiffness without 
considering Axial force

Stiffness considering 
Axial force

Stiffness and Dy are changed by axial force 
Under PMM or PM type.

Dy1
=Dy2

Du1

Stiffness without 
considering Axial force

Stiffness considering 
Axial force

Stiffness and Du are changed by axial force 
Under PMM or PM type

Du2

* Du1 - Dy1 = Du2 – Dy2

Du Update
(Add to Gen2021 newly)

Dy Update
(supporting in old version)

[Calculation of Du (= θu, Ultimate Rotation)] [Calculation of Dy (= θy, Yielding Rotation)]

௬ߠ = ݇ × ௬ߝ ÷ ݐ݈݊݁݉݁݁ ݂݋ ℎݐ݌݁ܦ
* εy : Yielding strain at tensile face

 Note



Gen 2021 v1.1 Release Note

11 /31

• Results > Results Tables > Story> Stiffness Irregularity Check, Capacity Irregularity Check, and Mass Irregularity Check

6. Irregularity reduction factors as per NSR-10

Output reduction factors (Phi_p)
Stiffness Irregularity Check

Capacity Irregularity Check

Mass Irregularity Check

According to Table A.3-7 in NSR-10,
Gen is reporting Reduction factor, ø in seismic 
design forces to account for Irregularity check 

• Regular Structures øa = 1.0
• Irregular Structures øa = 0.9
• Extreme Irregular Structures øa = 0.8

 Note

1.Stiffness Irregularity(Soft Story) Check

2.Capacity Irregularity (Weak Story) check

3.Mass irregularity Check

• Regular Structures øa = 1.0
• Irregular Structures øa = 0.9
• Extreme Irregular Structures øa = 0.8

• Regular Structures øa = 1.0
• Irregular Structures øa = 1.0
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Input of wind pressure by table editing
- Wind Pressure generated by equation can be edited in table and updated to the model.

7. Improvement of wind pressure function

midas Gen

Gen 2021 v1.1 (New version)

Inactive

When editing the table values, wind pressure is modified automatically.

Gen 2020
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• Provide rebar information for diameter, area, and weight in dialog box 
• Add #2 and #12 rebar in U.S Customary (U.S Imperial) DB

8. Renewal of Rebar Information Dialog Box

midas Gen

Gen 2021 v1.1 (New version)Gen 2020

Add #2 and #12 rebar 
in U.S Customary(U.S) code

In addition, provide the detail information for Rebar DB

Provide only the feature to select rebar size.
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9. Improvement of concrete shear strength in SMF as per ACI

Reduction factor (R) for Vc is not used in mid-span of member.
- ‘Vc=0’ is considered only both ends of the member.

Gen 2021 v1.1 (New version)

Gen 2020

 Note

Seismic provision in ACI 318M-19 

Vc in Design = R*Vc
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10. Beam End Offset for Asymmetric setting

Gen 2020

Gen 2021 v1.1 (New version)

Add element type (Asymmetric)
- Set a beam end offset by each direction. 
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11. Static earth pressure function

Add static earth pressure of function type.
- When editing the table values, earth pressure shape in the model is modified automatically.

Set Load Case & Direction

Select the function for Soil 
Properties

Set Loading Area

Check a  loading curve by level

Set Earth pressure type, 
Surcharge load, and water level

Load > Static Loads > Lateral > Earth Pressure > Static Earth Pressure

Calculating Sheet
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12. Elastic link graphic result in pushover analysis

Add graphic output of the elastic link (multi-linear type) in pushover analysis

Pushover >  > Pushover Results > Pushover Smart Graph > Elastic Link Graph 

Type of Result

1.[Force-Deformation] : Force/Deform.
2.[Force] : Force / Time
3.[Deformation] : Deformation/Time

Location/Component

Select Elastic Link

1.Location : Output position of elements
2.Component: Stress-Deform/ Moment-
Rotation angle In element axis.

Graph/Animation

Display Option

All elastic links assigned to the model are 
displayed in the list.
For same type, multiple selections are 
possible.

The animation function checks the results 
in a specific section.
It can be checked in conjunction with 
the table results

After checking each item, click the [Graph] 
button to apply it to the graph.
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13. Debonded Length of Pretensioned Beam

• Debonded length of pretensioned beam can be directly defined when creating strands from the ‘Tendon Profile’ dialog box. 
• Define the actual whole length of strand including debonded parts at both ends and then enter the lengths for debonded parts.

Load > Temp./Prestress > Prestress Loads > Tendon Profile

When debonded length has Non-Zero, Tendon Primary Moment Diagram

When debonded length has 0, Tendon Primary Moment Diagram
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14. Revit 2021 Interface

Gen-Revit Link
Functions Revit <> Gen

Linear 
Elements

Structural Column  <>
Beam  <>
Brace  <>
Curved Beam  >
Beam System  >
Truss  >

Planar
Elements

Foundation Slab  <>
Structural Floor  <>
Structural Wall  <>
Wall Opening & Window  >
Door  >
Vertical or Shaft Opening  >

Boundary

Offset  >
Rigid Link  >
Cross-Section Rotation  >
End Release  >
Isolated Foundation Support  >
Point Boundary Condition  >
Line Boundary Condition  >
Wall Foundation  >
Area Boundary Condition  >

Load

Load Nature  >
Load Case  >
Load Combination  >
Hosted Point Load  >
Hosted Line Load  >
Hosted Area Load  >

Other 
Parameters

Material  <>
Level >

 File > Import > midas Gen MGT File

 File > Export > midas Gen MGT File

Revit 2021 Gen 2021 v1.1 (New version)

Send Model to midas Gen
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1. Report of Excel format

Generate a report of excel format.

Member Report

Member List Report
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1. Report of Excel format

Excel Report LibXL Report

• Provides high-quality output

• All functions of Excel can be used.

• Very fast output generation speed

• Expression in the same format as Text Report
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2. SRC column module with box and pipe shape

 Applied Design Code : AISC-LRFD16(M),10(M)

 Applied Steel Shape : H section, Box, Pipe

Added Box and Pipe shape
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2. SRC column module with box and pipe shape

SRC column with Box section SRC column with Pipe section

Example

SRC column with H-section
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3. Midas link Option

Link Option > Member Data

 RC 
Column / General Section Column
Shear Wall / Combined Wall
Footing (Isolated/Combined/Strip)
Anchor Bolt

 Steel
Beam / Column
Bolt Connection (EC3)
Moment Connection( KSSC, AISC, EC3 )
Baseplate / Embedded Plate
Web Opening
Welding

 SRC
Column
CFT Column

 Aluminum
Beam / Column
General Section Beam / Column

 Reinforce
Reinforced Beam
Reinforced Column

- Supporting linkage feature for all combinations created in Gen

 Add “by all combination” type  in load combination type.

[ by All Load Combination ] Support List
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Example for “by All Combination” Type

1.Generate a load combinations and select a column. 

2. Set Load Combination Type to by All Load Combination

in Link Option> Member Data> Column tab.

3. Check Member No. and import Design information of members.

4. Check Member List in RC tree menu.

1

2

3

4

3. Midas link Option
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5. Click "Load Combinations” button.

6. Check a load combination name and end position of member before design/check.

* In the case of RC columns, member forces of I and J-end per load combination are imported.

Recommended to check the design position.

3. Midas link Option

Example for “by All Combination” Type

5

6
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4. Combined footing design as per Eurocode

Support combined footing design as per Eurocode 2: 04
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Procedure of Combined Footing Design

Define Section Define Load Define column information Define Rebar Arrangement

Step 1.
Define concrete, rebar material,
soil bearing 
and footing element information.

Step 2.
Define Load Data.
(Design load, factor, shear offset 
information)

Step 3.
Define column element 
and applied load information.

Step 4.
Define Bar arrangement layout & spacing

4. Combined footing design as per Eurocode
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Summary design report Detail design report

4. Combined footing design as per Eurocode
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5. Reporting speed for MS word format

• Reporting time for MS word format has been reduced by improving algorithm.

 National Code : Eurocode2:04
 Module: Combined Footing Design
 Report Page : 13 EA

Design+ 2020

Design+ 2021

28.66 sec

[Reporting Time :  Design+ 2020  vs Design+ 2021 (New Version)]

99% reduction in reporting time

0.41sec

Example Model ( RC structure of 6F )


